
Freezing row and column titles within 

Excel  
  

Freezing row and column titles  

• Open a workbook called Freezing.  

  

    

• Scroll down through the data and you will see that the title row, which 

contains a description of each columns contents, scroll out of sight.  This 

makes it difficult to remember what the data in each column represents, if 

you cannot see the column title row.  

  

    

• Make sure that you can see the title row displayed, as illustrated.  

  



    

• To freeze the top row so that it remains in sight at all times, click on the 

View tab and from within the Window group on the Ribbon, click on the 

Freeze Panes command.  

  

    

• From the drop down list displayed, click on the Freeze Top Row 

command.  

  

    

• Scroll down through the data.  As you can see the top row stays visible at 

all times now.  

  



 
   

  

• To unfreeze the top row, click on the View tab and from within the 

Window group on the Ribbon, click on the Unfreeze Panes command.  

  

   
  

TIP: You can use the same technique to freeze the first column, so that 

when you scroll to the right it is always visible.  To do this you would 

select the Freeze First  

Column command.  

  



    

• Save your changes and close the workbook.  

  



Printing 

There may be times when you want to print a workbook to view and share your 

data offline. Once you've chosen your page layout settings, it's easy to preview 

and print a workbook from Excel using the Print pane. 

To access the Print pane: 

1. Select the File tab. Backstage view will appear. 

 

2. Select Print. The Print pane will appear. 

 

Click the buttons in the interactive below to learn more about using the Print 

pane. 



 
To print a workbook: 

1. Navigate to the Print pane, then select the 
desired printer. 



 

2. Enter the number of copies you want to print. 



 

3. Select any additional settings if needed (see above interactive). 



 

4. Click Print. 



 

Choosing a print area 

Before you print an Excel workbook, it's important to decide exactly 

what information you want to print. For example, if you have multiple 
worksheets in your workbook, you will need to decide if you want to 

print the entire workbook or only active worksheets. There may also 

be times when you want to print only a selection of content from your 

workbook. 

To print active sheets: 

Worksheets are considered active when selected. 

1. Select the worksheet you want to print. To 

print multiple worksheets, click the first worksheet, hold 

the Ctrl key on your keyboard, then click any other worksheets you 

want to select. 

 

2. Navigate to the Print pane. 

3. Select Print Active Sheets from the Print Range drop-down 
menu. 



 

4. Click the Print button. 

 

To print the entire workbook: 

1. Navigate to the Print pane. 

2. Select Print Entire Workbook from the Print Range drop-down 
menu. 

 

3. Click the Print button. 

 



 

To print a selection: 

In our example, we'll print the records for the top 40 salespeople on the 

Central worksheet. 

1. Select the cells you want to print. 

 

2. Navigate to the Print pane. 

3. Select Print Selection from the Print Range drop-down menu. 



 

4. A preview of your selection will appear in the Preview pane. 



 

5. Click the Print button to print the selection. 



 

If you prefer, you can also set the print area in advance so you'll be able to 

visualize which cells will be printed as you work in Excel. Simply select the cells 

you want to print, click the Page Layout tab, select the Print Area command, 

then choose Set Print Area. Keep in mind that if you ever need to print the entire 

workbook, you'll need to clear the print area. 

 
Adjusting content 

On occasion, you may need to make small adjustments from the Print pane to 

fit your workbook content neatly onto a printed page. The Print pane includes 

several tools to help fit and scale your content, such 

as scaling and page margins. 

To change page orientation: 

Excel offers two page orientation 

options: landscape and portrait. Landscape orients the page horizontally, 

while portrait orients the page vertically. In our example, we'll set the page 

orientation to landscape. 

1. Navigate to the Print pane. 



2. Select the desired orientation from the Page Orientation drop-
down menu. In our example, we'll select Landscape Orientation. 

 

3. The new page orientation will be displayed in the 
Preview pane. 



 

To fit content before printing: 

If some of your content is being cut off by the printer, you can 

use scaling to fit your workbook to the page automatically. 

1. Navigate to the Print pane. In our example, we can see in 
the Preview pane that our content will be cut off when 
printed. 



 

2. Select the desired option from the Scaling drop-down 
menu. In our example, we'll select Fit All Columns on 
One Page. 



 

3. The worksheet will be condensed to fit onto a single 
page. 



 

Keep in mind that worksheets will become more difficult to read as 

they are scaled down, so you may not want to use this option when 

printing a worksheet with a lot of information. In our example, we'll 

change the scaling setting back to No Scaling. 

To include Print Titles: 

If your worksheet uses title headings, it's important to include these 
headings on each page of your printed worksheet. It would be difficult 

to read a printed workbook if the title headings appeared only on the 

first page. The Print Titles command allows you to select specific rows 

and columns to appear on each page. 



1. Click the Page Layout tab on the Ribbon, then select 
the Print Titles command. 

 

2. The Page Setup dialog box will appear. From here, you 
can choose rows or columns to repeat on each page. In 
our example, we'll repeat a row first. 

3. Click the Collapse Dialog button next to the Rows to 
repeat at top: field. 

 

4. The cursor will become a small selection arrow, and 
the Page Setup dialog box will be collapsed. Select 



the row(s) you want to repeat at the top of each printed 
page. In our example, we'll select row 1. 

 

5. Row 1 will be added to the Rows to repeat at top: field. 
Click the Collapse Dialog button again. 

 

6. The Page Setup dialog box will expand. To repeat a 
column as well, use the same process shown in steps 4 
and 5. In our example, we've selected to repeat row 1 and 
column A. 

7. When you're satisfied with your selections, click OK. 



 

8. In our example, row 1 appears at the top of every page, 
and column A appears at the left of every page. 

 

To adjust page breaks: 

1. Click the Page Break Preview command to change to 
Page Break view. 



 

2. Vertical and horizontal blue dotted lines denote the 
page breaks. Click and drag one of these lines to adjust 
that page break. 

 

3. In our example, we've set the horizontal page break 
between rows 21 and 22. 



 

4. In our example, all the pages now show the same number 
of rows due to the change in the page break. 



 

To modify margins in the Preview pane: 

A margin is the space between your content and the edge of the page. 

Sometimes you may need to adjust the margins to make your data fit 

more comfortably. You can modify page margins from the Print pane. 

1. Navigate to the Print pane. 

2. Select the desired margin size from the Page 
Margins drop-down menu. In our example, we'll 
select Narrow Margins. 



 

3. The new page margins will be displayed in the Preview 
pane. 



 

You can adjust the margins manually by clicking the Show 

Margins button in the lower-right corner, then dragging the margin 

markers in the Preview pane. 

 
 

Excel 2019 Formulas  
  

Creating formulas  

• Open a workbook called Formulas. Click on cell E3.    

  



   
  

In cell E3 we need to create a formula that will calculate the value of the 

stock for that particular component.  To do this we need to multiply the 

contents of cell C3 by the content of cell D3.  

  

• All formulas within Excel start with the 'equals' symbol.    

  

Type in the following formula.  

  

=C3*D3  

  

TIP: the * symbol means 'times'.  

  

Press the Enter key and you will see the result of the calculation in cell 

E3.  

  

• Click on cell E3 and you will see the formula displayed in the bar above 

the worksheet.  

  



    

The easy way to create formulas  

• Click on cell E4 and type in the equals sign.  

  

    

• Click on cell C4 and you see this.  

  

    

• Type in the * symbol, you see this.  

  



    

• Click on cell D4 and you will see this.  

  

    

• Press the Enter key and you see the result of the calculation.    

  

    

• This method may seem more complicated at first but when you are 

creating complex formulas, you will find this method is actually easier and 

helps to reduce errors, such as typing incorrect cell references.  

  

Copying formulas  

• Click on cell E4.  

• Move the mouse pointer to the bottom-right border of this cell and you will 

notice that the mouse pointer changes to the shape of a small, solid black 

cross.  When you see this shape change press the mouse button and 

while keeping the mouse button depressed, drag down to cell E9.  

Release the mouse button and you will see the formula copied down this 

range.  If you look at the formula in each cell of the range the cell 



references are automatically adjusted to match each row, i.e. row 8 

contains the formula =C8*D8, while row 9 contains the formula =C9*D9.  

  

Your screen will now look like this.  

  

    

• Save your changes and close the workbook.  

  

Operators  

 Operators sound complicated.  In reality they are items such as:   

  

 +   (plus)  

 -    (minus)  

  /   (divide)  

 *   (multiply)  

  

You use operators as part of your formulas.  There are other operators 

but these are the commonly used ones.  

  

Using operators in formulas  

• Open a workbook called Formula operators.  

• Click on cell C3 and enter the following which will add the number 3 and 

7:  

  

=3+7  

  

Press the Enter key and you will see the result displayed in the cell.  

  

• Click on cell C4 and enter the following which will subtract the number 4 

from the number 18:  

  

=18-4  



  

Press the Enter key and you will see the result displayed in the cell.  

  

• Click on cell C5 and enter the following which will divide the number 20 by 

the number 4:  

  

=20/4  

  

Press the Enter key and you will see the result displayed in the cell.  

  

• Click on cell C6 and enter the following which will multiply the number 4 

by the number 9:  

  

=4*9  

  

Press the Enter key and you will see the result displayed in the cell.  

  

• Save your changes and close the workbook.  

  

Formula error messages  

 When writing formulas, it is easy to make a mistake: listed below are some 

common error messages.  

  

#######  

The contents of the cell cannot be displayed correctly as the column is 

too narrow.  

  

#REF!  

Indicates that a cell reference is invalid. This is often displayed when you 

delete cells which are involved in a formula.  

  

#NAME?  

Excel does not recognise text contained within a formula.  

  

#DIV/0!  

This indicates that you have tried to divide a number by zero (0).  

  

Relative cell referencing within formulas  

• Open a workbook called Cell referencing.  

• The first worksheet within the workbook lets us look at relative 

addressing.  



• Click on cell E4.  We need to insert the formula for multiplying items in 

column C by the items in columns D.  Type in the following formula:  

  

=C4*D4  

  

• Press the Enter key and you will see the result of the calculation in cell 

E4.  

• Click on cell E4, and move the mouse pointer to the bottom-right corner of 

cell E4, and when the pointer changes to the shape of a small black 

cross, press the mouse button, and keep it pressed down.  Drag down the 

page to cell E12 and then release the mouse button.  

  

• If you click on cell E5 you will see the following =C5*D5.  

• If you click on cell E6 you will see the following =C6*D6.  

• If you click on cell E7 you will see the following =C7*D7.  

• If you click on cell E8 you will see the following =C8*D8.  

• If you click on cell E9 you will see the following =C9*D9.  

• If you click on cell E10 you will see the following =C10*D10  

• If you click on cell E11 you will see the following =C11*D11.  

• If you click on cell E12 you will see the following =C12*D12.  

  

• As you can see the referencing is completely relative.  This will become 

clearer when you have worked through the rest of this section.  

  

Absolute cell referencing within formulas  

• Click on the Absolute tab at the bottom of the worksheet.  

• Click on cell D4.  We need to enter a formula that will take the price and 

then add 5% to the price to give a total value.    

  

The 5% figure has been entered into cell C15.  

  

• Type in the following formula into cell D4.  

  

=C4*C15  

  

If you do the sums, you will find that this formula displays the correct 

delivery charge price in cell D4.  

  

• Click on cell D4, and move the mouse pointer to the bottom-right corner 

of cell D4, and when the pointer changes to the shape of a small black 

cross, press the mouse button, and keep it pressed down.  Drag down the 



page to cell D12 and then release the mouse button.  The data will look 

something like this.  

  

 
   

  

As you can see something has gone very wrong, as the 5% delivery 

charge appears to be 0 for most of the items.  

  

• Click on cell D5 and you can see what the problem is.  The formula 

contained within this cell is:   

  

=C5*C16  

  

Part of the cell reference points to cell C16 (which if you check is empty).  

The problem is that because of the relative nature of the formula, the 

component that should always refer to the contents of the cell in C15 (i.e. 

the delivery charge percentage), in fact moves down as you drag down 

the screen to extend your calculations.  

  

• Select the range D4:D12 and press the Del key to delete the cell 

contents.  

  

• Click on cell D4 and we will try again.  This time type in the following 

formula.  

  

=C4*$C$15  

  

The dollar signs make the reference to cell C15 absolute.  

  

• Try extending the formula to fill the range down to D12.  This time you 

should find that the delivery charges are calculated correctly.  

  



   
  

TIP: You have seen relative and absolute referencing.  You can also have 

mixed references, which contain an absolute and a relative reference.  

  

• Save your changes and close the workbook.  

  

 


